LAMPIRAN A
Gambar Processing Station MPS
LAMPIRAN B
LAMPIRAN C
## Contents

1. **Introduction** ................................................................. 47  
   1.1 Training contents .......................................................... 48  
   1.2 Important notes .......................................................... 49  
   1.3 Duty of the operating authority ....................................... 49  
   1.4 Duty of trainees .......................................................... 49  
   1.5 Risks involved in dealing with the Modular Production System .... 50  
   1.6 Warranty and liability .................................................... 51  
   1.7 Intended use .............................................................. 51  

2. **Notes on safety** ............................................................ 52  

3. **Technical data** ............................................................. 53  
   3.1 Combinations .............................................................. 53  

4. **Transport/Unpacking/Scope of delivery** ............................... 54  

5. **Design and function** ....................................................... 55  
   5.1 The Processing station .................................................... 55  
   5.2 Function ........................................................................ 57  
   5.3 Sequence description ...................................................... 57  
   5.4 Rotary indexing table module .......................................... 59  
   5.5 Testing module ............................................................ 60  
   5.6 Drilling module ............................................................. 61  

6. **Commissioning** ............................................................. 63  
   6.1 Workstation ................................................................. 63  
   6.2 Mechanical set up .......................................................... 64  
   6.2.1 Assembling profile plate and control console .................. 64  
   6.2.2 Assembling the station ................................................. 65  
   6.3 Adjust sensors ............................................................. 66  
   6.3.1 Capacitive proximity sensor (Rotary indexing table, detection of workpiece) ............................................ 66  
   6.3.2 Inductive proximity sensor (Rotary indexing table, Positioning) .................................................... 67  
   6.3.3 Inductive proximity sensor (Testing, orientation of workpiece) .................................................. 68  
   6.3.4 Micro switch (Drilling, linear axis) .................................. 69
## Contents

6.4 Visual check ................................................................. 70  
6.5 Cable connections .......................................................... 71  
6.6 Voltage supply ............................................................... 72  
6.7 Loading the PLC program .................................................. 72  
6.7.1 Siemens controller ......................................................... 72  
6.7.2 Festo/Beck controller ..................................................... 75  
6.8 Starting the sequence ....................................................... 80  
6.9 Combination of stations .................................................... 81  
6.9.1 Networking ................................................................. 81  

7. **Maintenance** ................................................................. 83  

### Appendix

- Assembly instructions ....................................................... 85  
- Equipment ................................................................. 85  
- Circuit diagrams ........................................................... 85  
- Program listings ............................................................. 85  
- Parts lists ................................................................. 85  
- Operating instructions ....................................................... 86  
- Data sheets ................................................................. 86  
- Updates ................................................................. 86  

© Festo Didactic GmbH & Co. KG • 648813
1. Introduction

The Festo Didactic Learning System for Automation is designed to meet a number of different training and vocational requirements. The systems and stations of the Modular Production System facilitate industry-orientated vocational and further training and the hardware consists of didactically suitable industrial components.

The Processing station provides you with an appropriate system for practice-orientated tuition of the following key qualifications

- Social competence,
- Technical competence and
- Methodological competence

Moreover, training can be provided to instil team spirit, willingness to cooperate and organisational skills.

Actual project phases can be taught by means of training projects, such as:

- Planning,
- Assembly,
- Programming,
- Commissioning,
- Operation,
- Maintenance and
- Fault finding.
Training contents covering the following subjects can be taught:

- Mechanics
  - Mechanical assembly of a station
- Electrical
  - Correct wiring of electrical components
  - Relay control (control section/power section)
- Handling technology
  - Checking the correctly positioned workpiece input
- Sensors
  - Correct use of limit switches
- PLC
  - Programming of logic control systems
  - Programming of parallel step sequences
- Commissioning
  - Commissioning of a production system
- Fault finding
  - Systematic fault finding on a production system

Topics for project work

- Reversing contactor circuit
- Selecting linear drives
1.2 Important notes

The basic requirement for safe use and trouble-free operation of the Modular Production System is to observe the fundamental safety recommendations and regulations.

This manual contain important notes concerning the safe operation of the Modular Production System.

The safety recommendations in particular must be observed by anyone working on the Modular Production System.

Furthermore, the rules and regulations for the prevention of accidents applicable to the place of use must be observed.

1.3 Duty of the operating authority

The operating authority undertakes to ensure that the Modular Production System is used only by persons who:

- are familiar with the basic regulations regarding operational safety and accident prevention and who have received instructions in the handling of the Modular Production System,
- have read and understood the chapter on safety and the cautionary notes in this manual.

Safety-conscious working of the persons should be regularly vetted.

1.4 Duty of trainees

Prior to commencing work, all persons assigned to working on the Modular Production System have a duty to:

- read the chapter on safety and the cautionary notes in this manual and,
- observe the basic regulations regarding operational safety and the prevention of accidents.
Introduction

1.5 Risks involved in dealing with the Modular Production System

The Modular Production System is designed according to state of the art technology and in compliance with recognised safety regulations. However when using the system there is nevertheless a risk of physical or fatal injury to the user or third parties or of damage being caused to the machinery or other material assets.

The Modular Production System is to be used only:

- for its intended purpose and
- in an absolutely safe conditions.

![Warning]

Faults impairing safety must be rectified immediately!
1.6 Warranty and liability

In principle all our „Terms and Conditions of Sale“ apply. These are available to the operating authority upon conclusion of the contract at the latest. Warranty and liability claims for persons or material damage are excluded if these can be traced back to one or several of the following causes:

- Use of the Modular Production System not in accordance with its intended purpose
- Incorrect assembly, commissioning, operation and maintenance of the Modular Production System
- Operation of the Modular Production System using faulty safety equipment or incorrectly fitted or non operational safety or protective devices
- Non observance of notes in the manual regarding transport, storage, assembly, commissioning, operation, maintenance and setting up of the Modular Production System
- Unlawful constructional modifications on the Modular Production System
- Inadequate monitoring of components subject to wear
- Incorrectly carried out repairs
- Catastrophies as a result of foreign bodies and vis major.

Festo Didactic herewith rules out any liability for damage or injury to trainees, the training company and/or other third parties which may occur during the use/operation of the system other than purely in a training situation, unless such damage has been caused intentionally or due to gross negligence by Festo Didactic.

1.7 Intended use

This system has been developed and produced exclusively for vocational and further training in the field of automation and technology. The training authority and/or the instructors is/are to ensure that trainees observe the safety precautions described in the manual provided.

The use of the system for its intended purpose also includes:

- following all advice in the manual and
- carrying out inspection and maintenance work.
2. Notes on safety

General
• Trainees must only work on the station under the supervision of an instructor.
• Observe the data in the data sheets for the individual components, in particular all notes on safety!

Electrics
• Electrical connections are to be wired up or disconnected only when power is disconnected!
• Use only low voltages of up to 24 V DC.

Mechanics
• Securely mount all components on the plate.
• No manual intervention unless the machine is at rest.

Drilling machine
• The drilling machine is operational. Therefore, stay at a safe distance from the rotating spindle!
• The polishing process is merely simulated for reasons of safety.
3. Technical data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage supply</td>
<td>24 V DC, 4.5 A</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>8</td>
</tr>
<tr>
<td>Digital outputs</td>
<td>8</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Di</th>
<th>Te</th>
<th>Pr</th>
<th>Ha</th>
<th>Bu</th>
<th>Ro</th>
<th>As</th>
<th>Pu</th>
<th>So</th>
</tr>
</thead>
<tbody>
<tr>
<td>Downstream stations</td>
<td>–</td>
<td>–</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>–</td>
<td>–</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Upstream stations</td>
<td>–</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td></td>
</tr>
</tbody>
</table>

Di: Distribution, Te: Testing, Pr: Processing, Ha: Handling (PicAlfa), Bu: Buffer, Ro: Robot, As: Assembly, Pu: Punching, So: Sorting
4. **Transport/Unpacking/Scope of delivery**

**Transport**
The MPS is delivered in a container with a pallet base.

The container must be transported on a suitable fork lift truck at all times and must be secured against tipping or falling off.

The carrier and Festo Didactic are to be notified immediately of any damage caused during transport.

**Unpacking**
Carefully remove the padding material in the container box when unpacking the station. When unpacking the station, make sure that none of the station assemblies have been damaged.

Check the station for any possible damaged once unpacked. The carrier and Festo Didactic are to be notified immediately of any damage.

**Scope of delivery**
Check the scope of delivery against the delivery note and the order. Festo Didactic must be notified immediately of any discrepancies.
5. Design and function

5.1 The Processing station

Processing is a generic term for production steps such as forming, form change, machining and joining. According to VDI 2860, forming is the creation of geometrically determined bodies made of formless substances. Form change is the changing of geometrical shapes and/or the dimensions of bodies. Machining is the changing of material characteristics and/or surface finish of bodies. Joining is the permanent joining of several bodies.

The function of the Processing station is

- To check the characteristics of workpieces (correctly positioned, hole)
- To machine workpieces and
- To supply workpieces to a subsequent station
The Processing station consists of the following

- Rotary indexing table module
- Testing module
- Drilling module
- Clamping module
- Sorting gate module, electrical
- Profile plate
- Trolley
- Control console
- PLC board
5.2 Function

In the processing station, workpieces are tested and processed on a rotary indexing table. The rotary indexing table is driven by a DC motor. The table is positioned by a relay circuit, with the position of the table being detected by an inductive sensor.

On the rotary indexing table, the workpieces are tested and drilled in two parallel processes. A solenoid actuator with an inductive sensor checks that the workpieces are inserted in the correct position. During drilling, the workpiece is clamped by a solenoid actuator.

Finished workpieces are passed on via the electrical ejector.

Note

The station uses exclusively electrical actuators.

5.3 Sequence description

Starting prerequisites

- Workpiece is in the workpiece retainer material input

Initial position

- Rotary indexing table positioned
- Checking solenoid plunger raised
- Drilling machine in raised position
- Drilling machine motor is switched off
- Clamping device retracted
- Electrical branch not actuated
Sequence

1. The rotary indexing table is rotated by 60°, if a workpiece is detected in the workpiece retainer 1 and the START pushbutton is pressed.
2. The solenoid plunger moves downwards and checks whether the workpiece is inserted with the opening facing upwards. The rotary indexing table is rotated by 60° if the result of the check is OK.
3. The clamping device clamps the workpiece. The motor of the drilling machine is switched on. The linear axis moves the drilling machine downwards.
4. When the drilling machine has reached its lower position, it is moved to its upper stop again by the linear axis.
5. The motor of the drilling machine is switched off and the clamping device is retracted. The rotary indexing table is rotated by 60°.
6. The electrical sorting gate passes on the workpiece to a subsequent station.

This sequence describes the passage of one workpiece through the Processing station. The workpiece is in the transfer position to a downstream station. The processing cycle can be started again, once a workpiece is inserted in the workpiece retainer 1.
5.4 Rotary indexing table module

The drive of the Rotary indexing table module is operated by a DC gear motor. The 6 rotating plate positions are defined by the positioning screws on the rotary table and sensed by means of an inductive sensor.

Each of the 6 semi-circular workpiece retainers of the plate is provided with hole in the centre to facilitate sensing by means of a capacitive proximity sensor.
5.5
Testing module

An inserted workpiece is checked for correct positioning. If the hole points upwards, then the armature of the testing solenoid reaches its end position.

An inductive proximity sensor is actuated via a nut at the upper end of the armature.
The Drilling module is used to simulate the polishing of the hole of the workpiece.

An electrical clamping device retains the workpiece. The feed and return actions of the drilling machine are effected by means of a linear axis with toothed belt drive. An electrical gear motor drives the linear axis and a relay circuit is used to activate the motor.

The motor of the drilling machine is operated via 24 V DC and the speed is not adjustable.

The end position sensing is effected by means of electrical limit switches. Approaching of the limit switches causes a reversal of the direction of movement of the linear axis.
Design and function
6. Commissioning

The stations of the Modular Production System are generally delivered

- completely assembled
- operationally adjusted as single station
- commissioned
- tested

**Note**
If stations are combined changes of the mechanical set-up and the position and setting of sensors may be necessary.

The commissioning is normally limited to a visual check to ensure correct tubing connections / wiring and supply of operating voltage.

All components, tubing and wiring is clearly marked so that all connections can be easily re-established.

6.1 Workstation

The following is required to commission the MPS Station:

- The assembled and adjusted MPS station
- A control console
- A PLC board
- A power supply unit 24 V DC, 4.5 A
- A compressed air supply of 6 bar (600 kPa), approx. suction capacity of 50 l/min
- A PC with installed PLC programming software
6.2 Mechanical set up

6.2.1 Assembling profile plate and control console

1. Profile plate
2. T-head nut M6 x-32 (4x)
3. Trolley
4. Socket head screw M6x10 (4x)
5. Screw 3.5x9 (2x)
6. Control console
6.2.2 Assembling the station

Instructions on assembling the station please find in the assembly instructions of the Processing station in the directory English\3_Processing\Assembly instructions on the CD-ROM supplied.
6.3 Adjust sensors

6.3.1 Capacitive proximity sensor (Rotary indexing table, detection of workpiece)

The capacitive proximity sensor is used for detection of workpieces. The workpiece changes the capacity of a capacitor built in the sensor head. Workpieces are detected independent of colour and material.

Note
Capacitive proximity sensors are used in the positions material input, testing and drilling.

Prerequisite
- The Rotary indexing table module is assembled.
- Proximity sensor is wired up.
- Power supply unit switched on.

Execution
1. Place a workpiece into the workpiece retainer.
2. Assemble the proximity sensor in the mounting bracket, avoid contact with the rotary indexing table. Position the proximity sensor centred below the drill hole of the workpiece retainer.
3. Adjust the distance proximity sensor – workpiece until the switching status display switches to on.

Note
Avoid activation of the proximity sensor by the rotating plate of the rotary indexing table.

4. Check position and setting of the proximity sensor (place/pick up workpieces).

Documents
- Data sheets
  Proximity sensor, capacitive (178575) in the directory English\3_Processing\Data sheets on the CD-ROM supplied.
- Assembly instructions
  Processing station in the directory English\3_Processing\Assembly instructions on the CD-ROM supplied.
6.3.2 Inductive proximity sensor (Rotary indexing table, Positioning)

The inductive proximity sensor is used for positioning of the rotary indexing table. Inductive proximity sensors detects metallic objects. The switching distance is a function of material and surface finish.

Prerequisite
- The Rotary indexing table module is assembled.
- Proximity sensor is wired up.
- Power supply unit switched on.

Execution
1. Assemble the proximity sensor in the mounting bracket. Position the proximity sensor centred below the positioning screw of the rotary indexing table. The distance proximity sensor – positioning screw is about 2 mm.
2. Adjust the distance proximity sensor – positioning screw until the switching status display switches to on.
3. Check position and setting of the proximity sensor by rotation of the rotary indexing table.

Documents
- Data sheets
  Proximity sensor, inductive (150395) in the directory English\3_Processing\Data sheets on the CD-ROM supplied.
- Assembly instructions
  Processing station in the directory English\3_Processing\Assembly instructions on the CD-ROM supplied.
6.3.3 Inductive proximity sensor (Testing, orientation of workpiece)

The inductive proximity sensor is used for testing the orientation of the workpieces. Inductive proximity sensors detects metallic objects. The switching distance is a function of material and surface finish.

Prerequisite
- The Rotary indexing table module and the Testing module are assembled.
- Testing module and proximity sensor are wired up.
- Power supply unit switched on.

Execution
1. Place a workpiece into the workpiece retainer. The hole points upwards.
2. Switch on the power supply of the coil of the Testing module.
3. Position the inductive proximity sensor in a distance of about 1 mm to the nut of the feeler of the Testing module.
4. Adjust the distance proximity sensor – nut until the switching status display switches to on.
5. Check position and setting of the proximity sensor by switching on and off the coil of the Testing module.

Documents
- Data sheets
  Proximity sensor, inductive (150395) in the directory English\3_Processing\Data sheets on the CD-ROM supplied.
- Assembly instructions
  Processing station in the directory English\3_Processing\Assembly instructions on the CD-ROM supplied.
6.3.4 Micro switch (Drilling, linear axis)

The micro switches are used for end stop sensing of the linear axis. The micro switches are actuated by the slide of the linear axis.

Prerequisite
- The Drilling module is assembled.
- Drilling module is wired up
- Micro switches are wired up
- Power supply unit switched on.

Execution
1. Move the drilling machine to the upper end stop.
2. Shift the micro switch in the mounting bracket oblong holes until it is actuated.
3. Fix the clamping screws.
4. Move the drilling machine to the lower end stop.
5. Shift the micro switch in the mounting bracket oblong holes until it is actuated.
6. Fix the clamping screws.
7. Start a test run to check if the micro switches are positioned correctly (move drilling machine upwards/downwards).

Documents
- Data sheets
  Micro switch S-3-E (007347) in the directory English\3_Processing\Data sheets on the CD-ROM supplied.
- Assembly instructions
  Processing station and Drilling module in the directory English\3_Processing\Assembly instructions on the CD-ROM supplied.
A visual check must be carried out before each commissioning!

Prior to starting up the station, you will need to check:

- The electrical connections
- The correct installation and condition of the compressed air connections
- The mechanical components for visual defects (tears, loose connections etc.)

Eliminate any damage detected prior to starting up the station!
6.5 Cable connections

Cable connections from PLC board to control console and station

1. **PLC board – station**
   Plug the XMA2 plug of the PLC board into the XMA2 socket of the I/O terminal of the station.

2. **PLC board – control console**
   Plug the XMG2 plug of the PLC board into the XMG2 socket of the control console.

3. **PLC board – power supply unit**
   Plug the 4 mm safety plugs into the sockets of the power supply unit.

4. **PC – PLC**
   Connect your PC to the PLC by means of a programming cable.
Commissioning

6.6 Voltage supply
- The stations are supplied with 24 V DC voltage (max. 5 A) via a power supply unit.
- The voltage supply of the complete station is effected via the PLC board.

6.7 Loading the PLC program

6.7.1 Siemens controller
- Controller: Siemens S7-313C, S7-313C-2DP, S7-314 or S7-315-2DP
- Programming software: Siemens STEP7 Version 5.1 or higher

1. Connect PC and PLC using the RS232 programming cable with PC adapter
2. Switch on power supply unit
3. Switch on the compressed air supply
4. Release the EMERGENCY-STOP pushbutton (if available)
5. Overall reset PLC memory:
   - Switch on the power supply unit and wait until the PLC has carried out its test routines.
   - Turn the mode selector switch to MRES and keep the mode selector switch in this position until the STOP LED comes on for the second time and stays on.
   - Let go of the mode selector switch to STOP. Immediately you must turn the mode selector switch back to MRES. The STOP LED starts to flash rapidly.
   - You can let go of the mode selector switch.
   - When the STOP LED comes on permanently the memory reset is completed.
   - The PLC is ready for program download.
6. CPU switch in STOP position
7. Start the PLC programming software
8. Depending on your controller type, retrieve the file 31x.zip from the directory Sources\PLC Programs\Release C\S7 of the CD-ROM supplied.

File → Retrieve ... → Select an archive (CD ROM: Sources\PLC Programs\Release C\S7) 31x.ZIP → Select destination directory OK → Retrieving: The retrieved data were stored in the project directory. OK → Retrieve: The following objects were retrieved. Do you want to open these now? Yes

9. Select the project 3BE_AS or 3BE_KFA
   (AS = sequential function chart, KFA = Ladder diagram/Function block diagram/Instruction list)
10. Download the project to the controller

**PLC → Download →** Follow the instructions on the screen

11. Turn the mode selector switch of the CPU to RUN position
6.7.2 Festo/Beck controller

- Controller: Festo/Beck FEC FC640, IPC CPU HC02, IPC CPU HC20
- Programming software: Festo FST Version 4.02
  or Klöpper und Wiege MULTIPROG wt Version 2.01

**Festo FST Version 4.02**

1. Connect PC and PLC using the TTL-RS232 programming cable
2. Switch on power supply unit
3. Switch on the compressed air supply
4. Release the EMERGENCY-STOP pushbutton (if available)
5. Start the PLC programming software
6. Restore the file 3BE_FEC.zip from the directory
   Sources\PLC Programs\Release C\FEC\FST of the CD-ROM supplied

![Image of software interface]

**Project → Restore ... → Open (CD ROM: Sources\PLC Programs\Release C\FEC\FST) 3BE_FEC.zip Open → Restore Project, Name: 3BE_FEC OK**
Commissioning

7. Compile the project

8. Download the project to the controller

Online → Download Projekt → Follow the instructions on the screen
Commissioning

Klöpper und Wiege MULTIPROG wt Version 2.01

1. Connect PC and PLC using the TTL-RS232 programming cable
2. Switch on power supply unit
3. Switch on the compressed air supply
4. Release the EMERGENCY-STOP pushbutton (if available)

Note
If you use the controllers Festo/Beck IPC CPU HC02 oder IPC CPU HC20, you first have to download the I/O configuration to the controller. Please proceed as follows:

5. Start the software „Transfer Tool“
6. Open the file MPSHCxx.mpr in the directory Sources\PLC programs\Release C\pcHCxx\MWT\IOConfig on the CD-ROM supplied

File → Open → Open file (CD ROM: Sources\PLC programs\Release C\pcHCxx\MWT\IOConfig, file type: *.mpr) MPSHCxx.mpr. Select Board 1 (Node 1). Click right and select Connect over → COM. Select Connect Speed 38.400 kB/s.

7. For rebooting the IPC switch it off and on

Select all files in the upper window. Click right and select Send file.
Commissioning

8. Start the PLC programming software
9. Unzip the project 3BE_FEC.zwt from the directory Sources\PLC Programs\Release C\FEC\MWT of the CD-ROM supplied

File → Open Projekt/Unzip Project → Open/unzip project (CD ROM: Sources\PLC Programs\Release C\FEC\MWT), File type: Zipped project files (*.zwt) 3BE_FEC.zwt Unzip → All following requests Yes
Commissioning

10. Compile the project

**Build → Rebuild Project**

11. Download the project to the controller

**Online → Resource Control → Send** → Follow the instructions on the screen
6.8 Starting the sequence

1. Check the voltage supply.
2. Remove the workpieces at the transfer points of the modules or stations prior to manual reset.
3. Carry out the reset sequence. The reset sequence is prompted by an illuminated RESET pushbutton and executed after the pushbutton has been actuated.
4. Insert the workpiece in the workpiece retainer.
5. Start the sequence of the Processing station. The start is prompted using the illuminated START pushbutton and carried out after the pushbutton has been actuated.

Notes

- The sequence can be interrupted at any time by pressing the EMERGENCY-STOP or the STOP pushbutton.
- With the key-operated switch AUTO/MAN you can select either the continuous cycle (AUTO) or individual cycle (MAN).
- The following applies in the case of a combination of stations: The individual stations are reset against the material flow.
- The warning light WORKPIECE NOK is illuminated if the workpiece is incorrectly inserted. Remove the workpiece manually and acknowledge by pressing the START pushbutton.
6.9 Combination of stations

6.9.1 Networking

In the standard version, the MPS stations are linked using optical sensors. This type of linking is known as StationLink, which uses through-beam sensor transmitters and receivers as sensors. The StationLink transmitter is mounted on the incoming material side and the StationLink receiver on the outgoing material side. By switching on or off the StationLink transmitter, the station signals the upstream station whether it is ready to receive a workpiece or busy.

The sensors for linking several stations must be arranged face to face in alignment. The linked stations must be securely interconnected by means of hammer head screws.

Note

In the case of the Distribution station, only the StationLink receiver is mounted and on the Sorting station only the StationLink transmitter.
7. Maintenance

The Processing station is largely maintenance-free. The following should be cleaned at regular intervals using a soft fluff-free cloth or brush:

- The lenses of the optical sensors, the fibre-optics and reflectors
- The active surface of the proximity sensor
- The entire station

Do not use aggressive or abrasive cleaning agents.
Maintenance
Appendix

Note
All documents listed below are stored as pdf-files in the directory
English\3_Processing on the CD-ROM supplied.

Assembly instructions
Processing station

Equipment
Processing station

Circuit diagrams
Processing station, electrical

Program listings
S7-314 Symbols table
S7-314 Overview
S7-314 Sequential function chart
S7-314 Function block diagram

Parts lists
Processing station
Rotary indexing table module
Testing module
Drilling module
Linear axis construction kit
Drilling machine construction kit
Limit switch construction kit
Clamping module
Sorting gate module, electrical
Appendix

**Operating instructions**

| Through-beam sensor, receiver | 369 662 |
| Through-beam sensor, transmitter | 369 679 |

**Data sheets**

| Drilling machine | 326 395 |
| Gear motor drilling | 526 867 |
| Gear motor rotary indexing table | 652 345 |
| I/O terminal | 034 035 |
| Linear axis with toothed belt drive DGEL-12 | 654 152 |
| Micro switch S-3-E | 007 347 |
| Proximity sensor, capacitive | 178 575 |
| Proximity sensor, inductive SIEN-M8 | 150 395 |
| Relay | 268 327 |
| Socket connector cable SIM-M8-3GD | 159 420 |
| Socket connector cable SIM-M8-4GD | 158 960 |
| Through-beam sensor, receiver | 165 323 |
| Through-beam sensor, transmitter | 165 353 |

**Updates**

Up-to-date information and additional documents for the Technical documentation of the MPS stations please find at the address:

http://www.festo.com/didactic

Services → Software → Mechatronics Assistant → Technical Support
An overview of the MPS® stations

Getting started with MPS®
Distributing station (V)

Focus on sensors
Testing station (P)

Purely electrical
Processing station (B)

Multitalented
Handling station (H)

Fits anywhere
Buffer station (PU)

High-end
Robot station (R)

Add-on for the robot
Assembly station (M)

Hydraulics packs a punch
Punching station (HS)

Last but not least
Sorting station (S)